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Introduction to the
CS425000 Accelerometer
Sensor

Application of industrial CMOS processes with a patented Micro-

Electromechanical-System (MEMS) ensures the highest reliability and

excellent long term stability. A 2-wire serial interface and internal voltage
regulation allows easy and fast system integration with a C Stamp. The Sensor is
compatible with the C Stamp microcomputer’s supplies and signal levels.

T he CS8425000 is an accelerometer sensor module with a digital output.

Registering Your C Stamp or C Stamp Related
Product

At A-WIT Technologies we respect your privacy; however, we do ask you to register
your C Stamp or C Stamp related product, so you can receive free of charge product
updates. The registration procedure is simple. Just send an e-mail to tech support@a-
wit.com with the word “REGISTRATION x” in the subject line, where “x” is the
product number that you purchased. If you purchased more than one product, send an
e-mail for each different product.

Introduction to the CS425000 Accelerometer
Sensor

The CS425000 is an accelerometer sensor module with a digital output. It can sense
gravitational (g) force of T4g on all three axes (X, Y, and Z). Application of industrial
CMOS processes with a patented Micro-Electromechanical-System (MEMS) ensures
the highest reliability and excellent long term stability. A 2-wire serial interface and
internal voltage regulation allows easy and fast system integration with a C Stamp. The
Sensor is compatible with the C Stamp microcomputer’s supplies and signal levels. The
device includes a MEMS accelerometer that is seamlessly coupled to a 13-bit analog to
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digital converter with a serial interface on the same module. This results in supetior
signal quality, a fast response time and insensitivity to external disturbances (EMC) at a
very competitive price. The 2-wire serial interface and internal voltage regulation allows
easy and fast system integration with a C Stamp. Its tiny size and low power
consumption makes it the ultimate choice for even the most demanding applications.
The Sensor is compatible with the C Stamp microcomputer’s supplies and signal levels.
Communicating with the Sensor is made easy with A-WIT's supplied software
command ACCSIN. This simple one command interface is all that is required to setup
and acquire from the sensor an acceleration vector in g’s for each of the X, Y, and Z
dimensions.

Technical Specifications

Measures £4 g on any axis

High precision acceleration sensor with a resolution of 976 ug’s
Uses MEMS (Micro Electro-Mechanical System) technology
Onboatd regulator and high-resolution ADC for simple connection to the C Stamp
SPI communications and function driver ACCSIN command
Power Requirements: 5 VDC

Dimensions: 0.8 x 0.9 in (20.3 x 22.9 mm)

Operating Temperature: -40 to +185 °F (-40 to +85 °C)

Fully calibrated, digital output

Excellent long-term stability

No external components required

Fast response time

Ultra low power consumption

Small size

Automatic power down

Applications include any type of tilt, motion, and vibration sensing.

8-pin DIP package
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Compact and breadboard-friendly

Compatible with C Stamp microcomputer

Detailed Pin Description

The figure below shows the pins arrangement of the CS425000, and the following
table shown the Detailed Pin Description.

CS UbD
CLK @ NC

ouT SEX
GND SE@

A-WIT wuwuw.c-stamp.com C5425000

Accelerometer Sensor Pin-Out Connectivity

Pin | Symbol Description

1 CS Select input
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Accelerometer Sensor Pin-Out Connectivity
Pin | Symbol Description
Connect to any C Stamp 1/O pin
2 CLK | Serial SPI clock input
Connect to C Stamp pin 28
3 OUT | Serial SPI output data
Connect to C Stamp pin 29
4 GND | Ground pin
5 SEO Select input
Connect to any C Stamp 1/O pin
6 SE1 Select input
Connect to any C Stamp I/O pin
7 NC No Connect
Do not connect
3 VDD | Supply5V

Polarity of the Acceleration Output

With the sensor module in the orientation shown in the figure below, the acceleration

vector axes are as follows:

x axis runs right to left with the left being the positive side
y axis runs top to bottom with the bottom being the positive side

z axis runs out of the page with the that direction being the positive side
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SENSOR

CS

CLK
OuT
GND

A-WIT wuuw.c-stamp.com CS5425000

If the sensor is accelerated into the indicated positive directions, the sensor will deliver
a positive acceleration signal.
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Getting Started

with the C Stamp. This assumes you have a C Stamp and an appropriate

connection kit or development board with the RESET and START circuitry,

and the Humidity Sensor propetly connected to the C Stamp. You will also
need a programming cable, power supply, PC running Windows® 2000/XP/Media,
with a quantity of RAM recommended for the OS, sufficient free hard disk drive space
for the software installations, CD-ROM drive, Internet access (recommended only),
and available port compatible with your programming cable.

T his chapter is a quick start guide to using the CS425000 Accelerometer Sensor

Notices

CSTAMP™ and CSTAMP™ Related Hardware Products, Software
Products and Documentation are developed and distributed by A-WIT
Technologies, Inc. All rights reserved by A-WIT Technologies, Inc. A-WIT
SOFTWARE OR FIRMWARE AND LITERATURE IS PROVIDED
“AS 1S, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO
EVENT SHALL A-WIT BE LIABLE FOR ANY CLAIM, DAMAGES
OR OTHER LIABILITY ARISING OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR FIRMWARE OR THE USE OF
OTHER DEALINGS IN THE SOFTWARE OR FIRMWARE.

MPLAB C-18 and MPLAB C-18 Users Guide is reproduced and
distributed by A-WIT Technologies, Inc. under license from Microchip
Technology Inc. All rights reserved by Microchip Technology Inc.
MICROCHIP SOFTWARE OR FIRMWARE AND LITERATURE IS
PROVIDED “AS 1S,” WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO
THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO
EVENT SHALL MICROCHIP BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY ARISING OUT OF OR IN
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CONNECTION WITH THE SOFTWARE OR FIRMWARE OR THE
USE OF OTHER DEALINGS IN THE SOFTWARE OR
FIRMWARE.

Getting Support

If possible, please check the C Stamp website www.c-stamp.com under SUPPORT for
any updates to documentation, changes, or notices that may have become available
since your Installation CD was produced. If you continue to have any issues for which
a solution is not found in the aforementioned website, please e-mail tech support@a-
wit.com for help.

Installing the Microchip MPLAB and C Compiler
Software

The first step is to install the Microchip MPLAB software that you will use to develop
your programs.

Insert your A-WIT provided Installation CD in your CD drive. Go to the MPLAB
directory in the CD and double click on the “MPLAB vX.XX Install” file in that
directory. Follow the installation steps, prompts, and directions provided by the
installer software, accepting all the default options.

After the MPLAB installation is complete, switch to the C18 directory in the CD, and
double click on the file in that directory. Follow the installation steps, prompts, and
directions provided by the installer software, accepting all the default options. The only
exceptions to accepting all the default options is that on the 5" and 6" windows of the

installation process for the C18 Compiler, you have to select everything as shown in
the figures below. This will ensure that MPLAB is configured to use the C18 Compiler.
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I the lizt below, gelect the checkbores for the desired
envirohment variable configuration options.

v Add MPLABE C18 to PATH environment wariable
v Add MPASM to PATH environmment sariable
v Add header file path to MCC_IMCLUDE environment vaniable

v Modify PATH and MCC_IMCLUDE wariables for all users

< Back

In the list below, select the checkboxes far the desired MPLAR
IDE configuration options.

v Update MPLAB IDE to use this MPLAE C18

w Update MPLAB IDE to use thiz MPLIME, Linker,
MPLIB Librarian, and MPASHM Aszembler

[v Place link to docurentation for this compiler in
MPLAE IDE Help Topics

v Perform MPLAE IDE updates for all users

Cancel
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Installing the AAWIT C Stamp Quick Programmer

To install the A-WIT C Stamp Quick Programmer, switch to the CSTAMPQP
directory in the CD using Windows Explorer, and double click on the file in that
directory. Follow the installation steps, prompts, and directions provided by the
installer software, accepting all the default options.

Installing the USB Software

If you purchased a product with a USB download cable, make sure that the A-WIT
provided CD is in the CD drive of your PC and insert the USB cable in the USB port
of your PC. Windows auto detects the new USB device. If Windows prompts you to
install drivers for the USB cable device, follow the installation steps, prompts, and
directions provided by the installer software, accepting all the default options.

After the USB adapter has been installed, open a Windows Explorer window from the
Accessories sub-menu in the Start menu, and right click on My Computer. Proceed to
select Properties, and then select the Hardware tab. Click on the Device Manger
button, and expand the Ports (COM & LPT) branch. Make a note of the COM port
that has been assigned to the USB-to-Serial adapter. This is the port that should be
selected in the C Stamp programmer software.

Setting Up the C Stamp Software Templates

To set up the C Stamp Software Templates, switch to the CSTAMP_Template
directory in the CD using Windows Explorer, and double click on the file in that
directory. Follow the installation steps, prompts, and directions provided by the
installer software, accepting all the default options.

Documentation

Copy the DOCS directory from the C Stamp Installation CD to your C:\A-WIT
directory. This directory contains all the C Stamp related documentation in PDF
format.
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Creating your Accelerometer Sensor C Stamp
Program

Create a directory where you want to have all the files for your program; for example
ACCS_APP. We recommend making this directory under your C:\A-WIT directoty,
so you can have all your CSTAMP related files in one place.

Copy the all files in your C Stamp Software Templates directory C:\A-
WIT\CSTAMP_Template to the ditectoty you just made.

Open the Microchip MPLAB IDE application. As shown the following figure, the
IDE has several sub-windows. Depending on the resolution of your screen, your sub-
windows may have a different layout. However; you can move and resize these into the
position that you want to fit your screen, and your layout for that particular project will
get saved upon answering yes to the prompt of saving the workspace when you exit
the software development environment.

v CSTRND Templata - MPLAL T VE.10

Fla Lt View Project Dstugger Programmer Tosk Configue Window Help

D@L %E SANT? | R Vo ZEBO | S m@

CSTAMBTamnpla..s o (1 OC | W0 WPLA IOF T ditor x

= x|
i

Checksum: Dxfiafil

L R s ]

* sunhar Date Canmant

PROJECT
SUB-
WINDOW

Bimclude *C3110000.L°

e EDITING
e s s .
WINDOW

Bkl | Vezon Coshiol | Frdwn Fles L MPLAG S84 | STM Liart)

Uua:a | Address | oynbol Name | Valus | Mex |
OUTPUT SUB-WINDOW WATCH SUB-WINDOW

MPLAE STH Pic1sFsEI0 = [ novedee A0MHE bark 0 Lo 30, Cal | [
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Go to the “File” menu to “Open Workspace...”. Then navigate to your program
directory, and open CSTAMP_Template.mcw.

Right click on CSTAMP_Template.mcp in the “Project” sub-window, and “Save
as...” the name of your program project after you have navigated to your program
directory. For example, your program project could be named “ACCS_APP”. Now
when you open the Microchip MPLAB IDE (Integrated Development Environment),
and go to your program directory to open the workspace for your program, you will
see a .mws file with the name of your program preceding it. This is the file that you
should open any time you want to work on your program.

Double click on the main.c source and type the following code fragment where it is
indicated. You can omit the comments for brevity, as they are written here to offer
clarifications of what the code does. Do pay attention; however, to the indentation of
the code blocks between curly brackets for loops, if statements, etc. Although
indenting the code is not a requirement for the compiler to parse your code (Le. any
blank spaces are ignored by the compiler), it does help tremendously to make your
code much more readable, and consequently, it makes finding any errors easier.
Keywords and function names in the code fragment below are bolded.

After you START the C Stamp in user mode as explained in the “Downloading and
Running Your Program” section (this will not be the RESET/BOOT/DOWNLOAD
mode), the program will run. This program assumes that your Acceleration Sensor is
correctly connected to the C Stamp with the clock pin connected to pin 28 and the
data pin connected to pin 29, the CS pin connected to pin 1, SEO connected to pin 4,
and SE1 connected to pin 5. You will also need LEDs connected to the C Stamp at
pins 46 through 39 each with a 287 €2 resistor as shown in the figure below for pin 46.
If you are using the CS310X00 BOL, then the LED connections are available in the
board already.

Fin 46
From C Stamp H#

LEDH R

287

The table below shows the connections between the sensor and the C Stamp.

Accelerometer Sensor C Stamp Connectivity

Pin | Symbol Description

11
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Accelerometer Sensor C Stamp Connectivity

Pin | Symbol Description

1 CS Select input

Connect to pin 1

2 CLK | Serial SPI clock input

Connect to C Stamp pin 28

3 ouT Serial SPI output data

Connect to C Stamp pin 29

4 GND | Ground pin

5 SEO Select input

Connect to pin 4

6 SE1 Select input

Connect to pin 5

7 NC No Connect

Do not connect

8 VDD | Supply 5 V

If you hold the BOL upright in front of you, you will see the following LEDs turning
on in response to the following motion or lack thereof, as shown in the table below.

BOL LEDs Response to Tilt/Position per the Example Program

Tilt LEDs Response

None All light up

BOL is straight and upright in front of

you

12
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BOL LEDs Response to Tilt/Position per the Example Program
Tilt LEDs Response
Rotate left (counter-clock-wise) LEDs on, except 1 and 5
Rotate right (clock-wise) LEDs on, except 4 and 8
Tilt forward (away from you) LEDs on, except 2 and 3
Tilt backward (toward you) LEDs on, except 6 and 7

The program executes indefinitely until you restart it by pushing and releasing the
RESET button while holding the START button and then letting go of the latter.

// interface pins
BYTE pins[] = {4, 8, 1};

float acc[3];

// rotation and tilt thresholds i
float GTL = -0.33; float GTR

float GTB 0.00; float GTF

n g’s
0.33;
0.67;

while(TRUE){
ACCSIN_CS425000(acc, pins);

if(acc[0] < GTL)
{STPIND(43, HIGH); STPIND(39, HIGH);
STPIND(46, LOW); STPIND(42, LOW);}
else if(acc[0] > GTR)
{STPIND(43, LOW); STPIND(39, LOW);
STPIND(46, HIGH); STPIND(42, HIGH);}
else
{STPIND(43, HIGH); STPIND(39, HIGH);
STPIND(46, HIGH); STPIND(42, HIGH);}

if(acc[2] < GTB)
{STPIND(45, HIGH); STPIND(44, HIGH);
STPIND(41, LOW); STPIND(40, LOW);}
else if(acc[2] > GTF)
{STPIND(45, LOW); STPIND(44, LOW);

13
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STPIND(41, HIGH); STPIND(40, HIGH);}
else

{STPIND(45, HIGH); STPIND(44, HIGH);

STPIND(41, HIGH); STPIND(40, HIGH);}

}

Save your program from the “File” menu or by clicking on the appropriate icon in the
tool bar. Then “Build All” from the “Project” menu or from the tool bar.

If the code was typed correctly, you will have a file in your program directory with the
name of your program project and a .HEX extension. An example is
ACCS_APP.HEX. This is the file that you will download to the C Stamp, as explained
up ahead.

If you get an error message or an indication that your program did not build
successfully in the “Output’” sub-window of the IDE, you probably have one or more
syntax error(s). Double click on the line of the “Output” sub-window that mentions
the error, and the program line that most likely contains the error will be indicated in
the sub-window where you were editing your program. Correct as necessary, and
“Build All” again until you get a successful . HEX file output.

14
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Downloading and Running Your Program

Power up your KIT, and connect the KIT to the PC with the provided cable. Upon
power up, the C Stamp will be in RESET/BOOT/DOWNLOAD mode. To go back
to this mode at any time, just push and let go of the RESET button. Then open the A-

WIT C Stamp Quick Programmer application shown in the next figure.

=3 CSTAMP(TM) Quick Programmer

FILE:  CSTAMP_Template.hex

PORT: CoOMz MOT CONMECTED Exik

COMPORT IOpen HEX Filel [ Conneck ] [ Wifrite Device J [ Disconneck
| Refresh [JauTo
COM2 | v [ l
WRITE STATLIS
j Marmal Mode
0 SECOMDS TO START 30 Toggle Debug

DEBUG SESSION INACTIVE:

Clear

The first step is to choose the serial port that you are using from the drop-down menu.
Then click on “Refresh”, so that the program registers your selection. Your selection
should show in the status area of the program next to “PORT:”. Then click on “Open
HEX File” and load/select the HEX file that you had previously created during the

15
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development of your program. The status are should indicate that the file has been
loaded successfully. This is what will be downloaded to the C Stamp. Then click on
“Connect”, and the PC will be connected to the KIT, and the status area should
indicate so. To download the HEX file to the C Stamp, just click on “Write Device”,
and you should see the progress bar after a few seconds, as the HEX file is
downloaded. At this point, you can click on “Disconnect” to disconnect the PC from
the KIT, disconnect the serial cable from both the PC and the KIT, and start your
program manually at the KIT. To do this just push and let go of the RESET button
while pushing the START button. Then you can let go of the START button.
Alternatively, you can click on “Normal Mode” to start your program from the PC.
This will also disconnect the program/PC from the KIT. Then you can disconnect the
serial cable from the PC and the KIT. You can also instruct the CSTAMP™ Quick
Programmer to wait several seconds before starting your program from the PC and
disconnecting by adjusting the “SECONDS TO START” slide. This feature is useful
in case you want to keep the PC connected with the serial cable, but need time to
manually set up something in a circuit that you have built. If this is not the case it can
just be left at the default of “0”, and your program will started from the PC right away.
Atfter you click “Normal Mode” and your program is started, the CSTAMP™ Quick
Programmer will not be communicating with the C Stamp any longer, so if you want
to reconnect, you must click on “Connect’ again.

16
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Accessory Specific
Functions and Commands
Reference

his chapter describes the functions and commands that are specific to the

software support of different types of accessories that are available from A-

WIT Technologies to complement the function and projects developed with

the C Stamp. The user should consult the manual for a specific accessory for
full information on connectivity and usage.

ACCSIN CS425000
void ACCSIN_CS425000(float acc[], BYTE Spins[]);

The ACCSIN function populates the &CC array with the X, Y, and Z acceleration
vector in g’s sensed by the A-WIT accelerometer sensor CS425000. The clock and data
lines of the sensor connect to the SPI clock and data in pins of the C Stamp. The select
pins of the sensor can be connected to any C Stamp pins, and they are passed to the
function in the SPINS  array. The &CC array has the following order: acc[0] = X
acceleration, aCC[1] = Y acceleration, and aCC[2] = Z acceleration. The select
pins in the SPINS  array are expressed in this order: SpINS[0] = SEO, Spins[1]
= SE1, and Spins[2] =CS.

acc is the name of the array of Floats that the function will use as storage to return
the acceleration vector to the calling function. This array must have three elements.

SpINS is an array that defines the C Stamp pin numbers that connect to the select
pins of the sensor. These pins are defined from the perspective of the sensor in this
order: SE0, SE1, and CS. The select pins can be connected to any C Stamp 1/O pins.
These pins will be set to output mode.

17
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Terms & Conditions
Quality Assurance

A-WIT has stringent quality control procedures in place to insure the best quality
products.

90-Day Limited Warranty

A-WIT Technologies, Inc warrants its products against defects in materials and
workmanship for a period of 90 days. If you discover a defect, A-WIT Technologies,
Inc. will, at its option, repair, replace, or refund the purchase price. After 90 days,
products can still be sent in for repair or replacement, but there will be a $10.00USD
minimum inspection/labor/repair fee (not including return shipping and handling
charges).

14-Day Money-Back Guarantee

If, within 14 days of having received your product, you find that it does not suit your
needs, you may return it for a refund. A-WIT will refund the purchase price of the
product in the form of a check, excluding shipping/handling costs, once the product is
received. This refund does not apply if the product has been altered or damaged. If you
decide to return the products after the 14-day evaluation period, a 20% restocking fee
will be charged against a credit.

Disclaimer

Warranty does not apply if the product has been altered, modified, or damaged. A-
WIT makes no other warranty of any kind, expressed or implied, including any
warranty of merchantability, fitness of the product for any particular purpose even if
that purpose is known to A-WIT, or any warranty relating to patents, trademarks,
copyrights or other intellectual property. A-WIT shall not be liable for any injury, loss,
damage, or loss of profits resulting from the handling or use of the product shipped.

How to Return a Product

When teturning, you must first e-mail sales@a-wit.com for a Return Merchandise
Authorization number. No packages will be accepted without the RMA number clearly
marked on the outside of the package. After inspecting and testing, we will return your
product, or its replacement using the same shipping method used to ship the product
to A-WIT within 30 days. In your package, please include a daytime telephone number
and a brief explanation of the problem.

Please contact our Sales Department at sales@a-wit.com if you have any questions
regarding our warranty policy or if you are requesting an RMA number.
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